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Chapter

What is TuneLab Pro ?

TuneLab is software that helps you to tune pianos. This software comes in various forms – for a Windows
laptop, iPhone, iPad, iPod Touch, and Android phones and tablets. Although these platforms are quite
different, most of the features of TuneLab are implemented similarly in all versions. This manual describes
TuneLab Pro for Windows laptops. There are separate manuals to describe TuneLab for these other
platforms. See www.tunelab-world.com for details.
Visual Tuning
TuneLab is one of the class of devices or software programs called “Visual Tuning Aids” or “Electronic
Tuning Devices”. These are devices or programs that provide a piano tuner with real-time guidance during
tuning. The sound of a note as it is played is picked up by a microphone and analyzed. The results of the
analysis are displayed in a visual pattern. In the case of TuneLab, there are two main visual patterns that are
displayed - the phase display and the spectrum display. Both of these displays indicate if the pitch of a note
should be raised or lowered, but each display has its own unique advantages. Having both displays visible
simultaneously gives the piano tuner the best of both worlds.
Phase Display

The phase display is the horizontal band shown above. This display is used for fine tuning. The black squares
move to the left if the note is flat and to the right if the note is sharp. The closer you get to the correct tuning,
the slower the black squares will move. The goal is to make the black squares come as much to a stop as
possible. If the piano string has any false beats, the black squares may appear to move in an irregular fashion,
sometimes moving back and forth. When there is no note playing, or when the note being played is far from
the correct pitch, the black squares will disappear or move randomly.
This display is called a phase display because it displays the phase of the sound from the microphone as
compared to the phase of an internally generated reference pitch, as in a strobe tuner. The movement of the
squares can be compared to listening to beats between a tuning fork and a note on the piano. For the bass and
midrange, when a square makes one complete trip around the display, that corresponds to one complete beat
that you would hear when comparing two tones. For higher notes the display is artificially slowed down in
order to keep the speed of the display in a reasonable range.
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Spectrum Display

The spectrum display is the graph shown above zoomed-in to ±130 cents around the desired pitch. Using the
Edit Options menu, you can choose to make the traces thicker (as shown) for easier visibility, at the cost of a
slight loss of resolution. This display shows how the sound energy is distributed across the frequency spectrum.
If TuneLab is listening to a pure tone, the spectrum graph will show a single peak. The example seen here was
made from a A-440 tuning fork that was a little flat. The red line in the center of the display marks the correct
pitch. The green lines nearest the center mark the points that are 10 cents above and below the correct pitch.
The green lines far from the center mark the points that are 100 cents above and below the correct pitch, i.e.
the previous note and the next note in a chromatic scale. The object in tuning with the spectrum display is to
tune the note until the peak of the graph is centered on the red line.
The spectrum display has several advantages over the phase display. One is that it shows where the pitch of the
piano is, even when that pitch is far from the correct pitch. The other advantage is that the spectrum display
can show several peaks at once. This is what you would get when playing a poorly tuned unison:

Here the piano note C7 is being played with one string tuned nine cents higher than the other two strings. By
looking at individual peaks it is possible to tune notes in the high treble without mutes! You simply tune one of
the strings and watch which peak moves. You can move that peak to the red line and then that string will be at
the correct pitch. However, tuning this way is not as accurate as tuning by sounding one string at a time,
because the multiple peaks tend to become blurred as they merge into one another.
The Spectrum Display can also be zoomed in on the center ±10 cents in the center, while still showing ±130
cents or ±260 cents overall. When one of these “dual-zoom” modes is selected, the numbers at the bottom
show offsets in cents rather than frequencies in Hz. Here is one such setting of the Spectrum Display showing
two simultaneous notes - one at A6 and the other at A#6 (+100 cents higher than the target pitch):
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As shown in the upper right corner of the previous Spectrum display, if a tone is recognized close enough to
the target pitch, there will be a numerical display of the tuning error in cents – in this case, -0.6 cents.
One advantage of the phase display is that it generally provides more resolution than the spectrum display,
except in the highest octave where the resolutions are about the same. For this reason the spectrum display is
used for rough tuning and the phase display is used for fine tuning. False beats can confuse the phase display
though. So the spectrum display is preferred even for fine tuning in the high treble. In any case, both displays
are available; so you can use whichever display seems to be giving the clearest indication.
Toolbar
TuneLab Pro uses a toolbar for many functions. Here is the toolbar from TuneLab Pro:

New Tuning File - prepares for creation of a new tuning, and may start auto measure sequence
Open Tuning File - selects and loads an existing tuning file
Save Tuning File - saves the current tuning as a file so it can be recalled later
Sound On/Off - toggles the sound generation mode on and off
Offsets - manages overall offset and custom stretch values
Lock Mode - begins locking onto the note by automatically adjusting the offset (“.” also works.)
Zoom Spectrum In/Out - zooms through 6 different zoom levels (“-” and “+” also work.)
Auto Note Switching - enables auto note switching
Auto Note Switch, One Direction - enables auto note switching in just one direction
Measure Inharmonicity - measures inharmonicity (“M” also works.)
Over-pull - enables/disables over-pull (pitch raise) mode (function key “F2” also works.)
Historical Temperaments - selects optional non-equal temperaments
Tuning Curve - displays the tuning curve for adjustment or review (“T” also works.)
All these toolbar buttons have associated tooltips. To see a tooltip, merely move the mouse cursor so that it
rests on one of these buttons. After a short pause a box will appear with a reminder about what that button
does. If there is a keyboard key that performs the same function, the tooltip will tell you about it.
Current Settings Display
In the middle of the main TuneLab display screen in large letters there is a display of the currently selected note.
Above the phase display is a display of current settings. Usually most of these fields are blank; but here is an
example with all the fields active:
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Here is a description of each of these fields, reading down the left column and then the right column:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Tuning File Name - the name of the tuning file currently in use (“MyKawai.tun”)
Temperament Name - the name of the temperament file, if one is selected (“Bremmer EBVT-3”)
Tuning Partial - which partial (or fundamental) is used for tuning the current note
Frequency - the calculated frequency, taking into account all offsets (“556.474”)
Offset - the overall offset from standard A-440 pitch in cents (“0.60”)
Custom Stretch - the offset (if any) manually programmed for the current note only (“6.27”)
Template Stretch - the offset calculated from the tuning curve (“0.79”)
Temperament Offset - the offset from the optional historical temperament in effect (“-1.08”)
Note Switching - “Auto up” in this example, tells which form of hands-free note switching is in effect
Microphone Level Indicator
To help verify that your microphone is working properly, TuneLab provides a display of the
microphone level in the right edge of the spectrum display. When all is quiet, the level should be
below 1%. When the microphone hears normal piano tuning the level should produce a level of at
least 50%. If the reported level is nowhere near these levels, then check your microphone and check
the multimedia settings in your computer’s Control Panel to see if some system volume control is
improperly adjusted. The green bar shown here shows a mic level of about 80%.

Tuning Curve Adjustment
By default the tuning curve is calculated automatically based on inharmonicity measurements. But if you want
to override this default you can make some manual adjustments. See Chapter 3 for details.
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Partials
Each note is tuned according to its
fundamental pitch or the pitch of one of its
partials. The current settings box shows
which partial is being used. The selection of
partials comes from a table of partials. This
table may be modified from the screen
shown to the right. The table shows the
partial number for each note from A0 to B7.
Using the < and > buttons you can lower
or raise the partial for the highlighted note.
You can highlight a different note by
clicking on the partial number for that note.
Since the same partials are generally used by
a group of notes, the Dup button is
provided to duplicate the highlighted partial
into the next note and move the highlight.
In this manner you can quickly set an entire
section of notes to the same partial. The Store as default button makes the partials selected become the default
partials for all future new tunings.
The table of partials is stored along with the tuning curve in the tuning file when you save a tuning. By
modifying this table you can customize the partials used for tuning when that tuning file is loaded. Whenever
you begin a new tuning, the table of partials is initialized from the default settings, which you can change with
the Store as default button. Partials can also be changed on-the-fly using the function keys F3 and F4 or by
dragging the mouse left or right across the Spectrum Display (or swiping with a touchscreen). These on-the-fly
changes are not stored in the table of partials and are canceled when a new note is selected, unless you have
enabled “Persistent Partials” under Edit Options, in which case changes made on-the-fly are immediately
incorporated into the current tuning file.
Inharmonicity
Inharmonicity is the name given to the phenomenon whereby the partials of a piano string are not exact
multiples of a fundamental frequency. TuneLab assumes that the partials are offset from their exact wholenumber multiples of the fundamental by an amount that increases with the square of the partial number and is
proportional to the inharmonicity constant for the given string. When TuneLab measures inharmonicity for a
string, the pitches of all the partials of that string are analyzed and an inharmonicity constant is generated for
that string. The inharmonicity constants are stored in the tuning file when a tuning is saved. You usually don’t
need to be concerned with the actual values of the inharmonicity constants that you measure; but you can see
and edit them from the Edit menu. In a well-scaled piano you can expect to see the lowest inharmonicity
constants somewhere in octave 2. From there the inharmonicity constants increase slightly as you move down
to A0 and they increase substantially as you move up to C8, as shown below. TuneLab uses the specific
samples that you collect to find a best-fit inharmonicity model for the entire scale. Using this model, TuneLab
makes all the calculations regarding how partials relate to one another.
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Typical Inharmonicity Values for a Kawai Grand
Over-pull Mode
When raising or lowering the overall pitch of a piano by a significant amount, you will find that the notes that
you tune first are changed by the time you are done tuning. This is due to the interaction of the string tensions,
primarily through the bridge and soundboard and the flexing of the plate. When an entire section of notes is
raised in pitch, the result is that the notes that were tuned first will tend to drop in pitch. Even the notes that
you tuned last will drop somewhat due to the delayed settling of tension in the wire.
Over-pull tuning mode compensates for this change by setting tuning targets that are a calculated amount
beyond the desired pitch. In this way the change that occurs will leave the notes right where you want them.
In many cases using just one pass with over-pull tuning can take the place of tuning the piano twice. Over-pull
mode accomplishes this goal using a process that has two phases. In the first phase you pre-measure the
piano's pitch by playing a set of notes that TuneLab measures quickly. No tuning is done in this first phase.
Then after the pre-measuring is done the second phase of over-pull mode lets you tune the piano. During this
second phase TuneLab adds an over-pull offset onto each note to compensate for the expected drop in pitch
after the tuning is done. These over-pull calculations are entirely automatic. The complete procedure for overpull tuning is described more fully in Chapter 4.

Calibration
TuneLab can be calibrated for exact pitch. Without calibration, TuneLab assumes a nominal crystal oscillator
frequency in your computer's sound system and makes all pitch calculations from that assumption. By doing a
calibration you are compensating for whatever difference there may be between the nominal crystal oscillator
frequency and the actual oscillator frequency in your particular computer, based on a comparison to a trusted
pitch source. You can do a rough calibration using a tuning fork, but your final calibration should be through
internet time servers, or with some more precise source, such as the NIST phone service described later. The
result of a calibration is a revision of the actual sample rate of the sound system, which is shown in the About
box. Normally, calibration is done only once when TuneLab is first installed on your computer. See the
chapter on calibration later in this manual for details on doing a calibration.
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Automatic Note Switching
Using the menu or the keyboard or the mouse you can enable different forms of automatic note switching.
There is auto up, auto down, auto both, and manual. In manual mode the note TuneLab is listening for will
not change unless you manually change it by using the arrow keys or clicking in the spectrum display. In the
three automatic modes TuneLab listens for nearby notes and switches to them when you play them. Auto
both will switch to any note within 300 cents of the current note, above or below the current note. Auto up
will only switch to a note that is within 300 cents up from the current note. Similarly auto down will only
switch in the downward direction. When measuring inharmonicity a special type of note switching takes over
and switches through a pre-defined list of notes that you want to measure for a new tuning.
In TuneLab Pro, the different forms for automatic note switching can be enabled with the keyboard. ShiftRight-Arrow and Shift-Left-Arrow enable auto note switching in the indicated direction. Press both arrows at
once to enable both directions. However the easiest way to turn auto note switching on or off is to click and
drag from the Current Note display to the right or the left. Dragging to the left turns auto note switching off
and dragging to the right turns it on. You can also cycle through the three kinds of auto note switching by
clicking the Auto Note button repeatedly.

Historical Temperaments
By default, TuneLab assumes an equal tempered scale. If you would like to tune in some unequal temperament
(not usual), you can select an historical temperament file to apply to your tuning. An historical temperament
file contains a list of 12 offsets for each of the 12 notes of an octave. When an historical temperament is
selected, one of these 12 offsets is used, depending on which note is selected. For any given note, the same
offset is used in every octave. In addition, the temperament offset may be optionally normalized. This means
that all 12 offsets will be shifted by the same amount before they are used. You can choose to have the offsets
normalized so that the offset for A is always zero; you can choose to normalize so that the average offset is zero
(to minimize the overall change from equal temperament); or you can choose to use the historical
temperaments just as they are with no normalization. The temperament name and the temperament offset for
the selected note appear in the Current Settings box shown previously. When you save a tuning the historical
temperament values (and temperament name) are saved in the tuning file. See the chapter on special functions
for information on making and using temperament files.

Tuning Files
A tuning file is a file made by TuneLab and stored usually in My Documents/TuneLab. In this file are all
the factors necessary to re-create a specific tuning. You can save the current tuning to a named file, or open an
existing tuning file from the File menu. You can also save a tuning file by clicking on the diskette icon in the
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toolbar. If you want to organize your tuning files into several folders (like “Churches” and “Homes” or
“Grands” and “Verticals”) under the one home folder, you can create these other folders as you save tuning
files. When you save a tuning file, you will see a standard Windows “Save As..” dialog box. The appearance of
that box will depend on which version of Windows you are running. But all versions offer some way to select
different folders and to create new folders. Examine all the elements of your “Save As..” dialog box and you
will find a way.
Here is what a tuning file contains:
·
·
·
·
·
·
·

The inharmonicity constants for all the notes that you measured.
The adjustment settings of the tuning curve (the template).
The name of the historical temperament (if any) and all 12 offsets from that temperament.
The partial and custom offset (if any) for each of the 88 notes.
The selection of bass and treble intervals in the tuning curve adjuster.
The Over-pull selections in effect at the time the file was saved.
The overall offset in effect at the time the tuning was saved.

Sound Generation
Although the common use for TuneLab is in listening to notes and providing a visual tuning aid, you can also
use TuneLab as a tone generator. When TuneLab is in sound generation mode, the spectrum display and
phase display are disabled. The pitch of the sound generated in the speakers is the same as the pitch that would
have indicated correct tuning in the listening mode. The pitch is generated for whichever partial is selected not necessarily the fundamental. Sound generation using low pitches may not be audible due to the limitations
in the frequency response of the speakers found in laptop computers.
Sound generation is generally used to aid in stringing operations where precision is not as important as in
normal tuning. If you intend to use sound generation for precise tuning in TuneLab Pro, you should be aware
of the fact that some laptops use two separate crystal oscillators in their sound output and sound input
operation. Therefore a separate calibration may be needed for the sound generation mode. If this is the case
with your laptop, you should do the separate output pitch calibration as described in the chapter on calibration.
Even if your laptop has only one sound crystal, it does not hurt to do a separate calibration for the tone
generation. If you don’t plan on using TuneLab to generate precise tones, you don’t need to do this special
output calibration.
Note Selection
Using the mouse you can change notes by clicking in one of
the four quadrants of the spectrum display. Clicking in the
upper quadrants switches up or down an entire octave.
Clicking in the lower quadrants switches up or down by a
single note. You can also select a note using the keyboard
by pressing the letter and then the octave number for the
note on the keyboard. To select a sharp, use the right arrow key after selecting the natural, or use UPPER
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CASE letter to select the sharp directly. You can also select notes by using the right and left Arrow keys to
move up and down the scale. You can change octaves with the Page Up and Page Down keys. During a
normal tuning it is most convenient to switch notes automatically using auto note switching.
Tuning Closeness Indicator
The current note display has a region on the bottom that indicates how close your tuning is to the target pitch.
Here are some examples:

more than one
cent off

slightly less than
one cent off

half a cent off

nearly perfect

As these examples show, the gray bars start appearing when the tuning is within one cent of the target pitch;
they close down and meet in the center at zero cents.
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Chapter

Normal Tuning Procedure

This chapter takes you step-by-step through an ordinary piano tuning (not a pitch-raise). We are also
assuming that you have not tuned this piano before and saved a tuning file, because if you had, then you
could skip the initial setup and just load that tuning file now and begin tuning.
Initial Setup
Tuning with an electronic tuning aid can be done with just two mutes. First check the condition of the existing
tuning to see if there are any major problems with the piano and to see if a pitch raise is necessary. Assuming
that a pitch raise is not necessary, the next step is to measure the inharmonicity of the piano.
When TuneLab is started it will have a tuning file name such as “untitled-1”. If you have some other tuning file
loaded as the current tuning you should clear out that tuning and start a new tuning by selecting the
toolbar button shown here. This will clear out any old inharmonicity constants and reset the table of
partials to the default. You are now ready to develop a new tuning. TuneLab will now switch to the first note
in your “measure sequence” and start the inharmonicity measurement. Depending on your option
settings the measurement may start immediately or you may have to click on the measure button first.
Measuring Inharmonicity
Start by measuring the inharmonicity of at least four notes and preferably six notes. The default measure
sequence is the C notes from C1 to C6. If the piano is a spinet that is known to have a large break in the
inharmonicity, you may want to consider using the Split Scale mode, as described in the Special Functions
chapter. For now, we will assume that the piano is a well-scaled instrument that does not require Split Scale
mode. We will measure the C notes from C1 to C6. If one of these notes is hard to measure accurately
because of a serious false beat or lack of partials, then just measure some other nearby note instead. The graph
in Chapter 1 shows typical inharmonicity measurements of a Kawai 6’8” grand. In any case, when you measure
the inharmonicity of a note you should mute all but one string of the note. Measuring the inharmonicity of two
or three strings sounding at once is not recommended.
To measure the inharmonicity of a note, select that note in TuneLab, as described in Chapter 1 under “Note
Selection”. (That selection may have been done for you if you had set up an auto measure sequence in Edit
Options.) Now that TuneLab is showing the note that you want to measure, if the measurement has not
already been initiated by the auto measure sequence, begin a measurement by pressing M on the keyboard or
by clicking on the measure button:
This will cause a status box to appear showing “Measuring, waiting
for trigger”. TuneLab will begin listening to the note as soon as you play it. The sudden rise in sound level is
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the trigger. If you do not play the note shortly after initiating a measurement it is quite likely that some
extraneous noise may trigger the sampling period and you will get a false reading. If this happens, just wait for
the calculation to finish and then discard the reading and start over. If the “Auto Measure” option has been
enabled, then you do not need to switch notes or start each measurement because this will be done
automatically for you.
When sampling for inharmonicity you should play the note that you want to measure and then watch the status
box change from “waiting for trigger” to “listening”. This listening period is about six seconds for low notes
and progressively shorter for higher notes. If the piano is in good condition the sustain period of the note
should last to the end of the “listening” period. After the listening period TuneLab will calculate the
inharmonicity and display a results box showing what was measured. In some notes with too-soft hammers, the
partials are so weak or ill-defined that they cannot be measured. In that case it may be useful to pluck the string
rather than strike it using the key. If you pluck the string, pluck it near the termination point to get a rich set of
partials. This is generally needed only for very high notes.
The only value that is saved from the inharmonicity measurement is the inharmonicity constant. The graph in
Chapter 1 shows the typical pattern of inharmonicity constants for a Kawai 6’8” grand (model 650). Other
pianos may have more or less inharmonicity, but the pattern should be approximately the same. The graph
stops at C6, but in almost every case, the actual inharmonicity continues in the same pattern of rising
inharmonicity established by the lower octaves. So you can avoid measurements in the highest octaves and still
have an accurate picture of the inharmonicity of the piano.
When a measurement is complete,
TuneLab displays a box like the one
shown to the left. Here we see that
pitches were detected for the
fundamental and partials 2 and 3.
Some of partials 4-6 were detected,
but they were too weak to be used
for measuring inharmonicity. The
offset column shows the offset in
cents for the individual partials as
compared to what they would be if
there were no inharmonicity.
Generally there is more inharmonic
offset the higher you go in the
partial series.
The amplitude
column shows the relative strengths
of the specific partials. TuneLab analyzes the pattern of partial offsets and calculates an inharmonicity constant
for the string - in this case 0.632. If things look reasonable at this point then you would select Save, which will
save the inharmonicity constant for the note C5. You can also select Save,+ which will save the measurement
and then begin another measurement of the same note so that you may average several readings of one note.
This is especially useful when using the auto-measure sequencing where Save,+ will allow you to take additional
readings of the same note without canceling the auto-measure sequence. In this box you can also view the
partial amplitudes in graphical form using the horizontal bar graph, which is explained in Chapter 6 in the
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section on Voicing. If you measure inharmonicity again for the same note, the inharmonicity readings will be
averaged.
Adjusting the Tuning Curve
Now that the inharmonicity readings have been taken, TuneLab forms a model of the inharmonicity of all the
notes of the scale. Using that model, TuneLab can predict how various intervals will sound. In automatic
adjustment mode TuneLab uses that prediction to find an adjustment of the tuning curve that is optimized for
the intervals you have selected. In manual or semi-automatic mode you can adjust the curve yourself. This
tuning curve is sometimes called the template tuning curve because it follows a four-parameter template.
Subjective value judgments can play a role in how tuning curve adjustments are to be made . Normally we
recommend fully automatic adjustment mode, which you can select using the toolbar buttons at the top of
the adjuster screen. When the fully automatic mode is selected, you can cause the automatic adjustment to be
made by pressing U on the keyboard, or clicking on any of the four Auto buttons below the tuning curve.
Refer to the picture of the tuning curve in Chapter 1. You get to this screen by pressing T on the keyboard or
by clicking on the tuning curve icon in the toolbar. You are also taken to this screen automatically at the end of
a sequence of inharmonicity measurements for a new tuning. Note the buttons that select between the three
different ways of adjusting the tuning curve:
This button selects the totally manual method of adjusting the tuning curve. When this option is used,
you must use the adjuster arrows to adjust all four aspects of the tuning curve, which are overall stretch
in the treble and in the bass, and the shape of the bass and treble portions of the curve.
This button selects the semi-automatic method. The overall stretch in the treble and the bass are
calculated automatically, but you must manually adjust the shape of the treble and the bass using the
remaining adjuster arrows.
This button selects the fully automatic method. All four aspects of the tuning curve are adjusted
automatically when you touch any of the adjuster arrows, which now will say “Auto” instead of showing
a picture of an arrow.
If you do not choose the fully automatic method, you must adjust the curve by clicking and dragging up or
down through the green bands in the graph background. The bands at the extreme left and right control the
overall stretch in the bass and the treble. The inner bands control the shape of the bass or treble portion of the
tuning curve without changing the overall stretch.
Although tuning curve adjustments can be carried out by clicking
and dragging the mouse, for compatibiltiy with older versions of
TuneLab you can also use the keyboard for these actions. The
mappings shown to the left are in effect. This mapping shows the
inner two adjustment bands are mapped to U, I, J, and K. The outer
two adjustment bands map to Y, O, H, and L (in fully manual mode
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only). If you are using the fully automatic method of tuning curve adjustment, then you can skip the
adjustment details.
In the course of doing an adjustment you may find that a portion of the tuning curve goes off the scale. If this
happens and you want to see the whole curve, press the Z key (for “Zoom”). This will toggle the graphical
limits between the original limits and the limits that exactly contain the current curve.
Now that you have become familiar with the mechanics of adjusting the tuning curve, it is time to adjust the
tuning to match your tuning criteria. You may want the 6:3 octaves in the low bass to be as pure as possible
and the 4:1 double octaves in the treble to be as pure as possible. Do that by selecting these intervals in the
selection boxes located around the adjuster arrows. Open these drop-down selection boxes by clicking on the
little triangle after the interval name. Scroll through the choices and tap or click on 6:3 in the left selection box
and 4:1 in the right selection box. TuneLab will remember your preference and these intervals will always be
selected for you when you start a new tuning. In addition, the interval selections for each tuning will be stored
in the tuning file, so you can have different interval selections with each tuning file.
Now that you have the proper intervals selected, the deviation curve (the lower curve) shows you how your
selected intervals will sound. The goal is to adjust the tuning curve until the deviation curve is as straight as
possible at both ends. This is, in fact, what the fully automatic adjustment method does. You will notice that
the right-hand adjuster buttons control the shape of the treble end of the tuning and hence the shape of the
treble end of the deviation curve. If the deviation curve is bowed up in the middle, press the down adjuster
arrow. If the deviation curve is bowed down in the middle, press the up adjuster arrow. Unless you are using
the totally manual method, the ends of the deviation curve will always be at zero. Your goal in adjusting the
shape is to get as much of the deviation curve as possible to lie close to zero.
When you adjust the shape of the bass end of the tuning curve you will notice that the deviation curve moves
in the opposite direction as the tuning curve. This behavior is a consequence of the way the deviation curve is
defined. If the bass end of the deviation curve is bowed up in the middle, press the up adjuster button. If the
bass end of the deviation curve is bowed down in the middle, press the down adjuster button.
The Zoom function was mentioned earlier in relation to containing the tuning curve. The Zoom function also
scales the graphical display of the deviation curve.
When you get the deviation curve to look something like the one shown in the picture in Chapter 1, you are
done. Notice that the deviation curve does not hold very close to zero at the transition in the middle. That is
normal and expected. As you move from the bass to the treble, your criterion for a good tuning gradually
changes from making 6:3 octaves beatless to making 4:1 double octaves beatless. Midway through that
transition the 6:3 octaves will be a little narrow and the 4:1 double octaves will be a little wide. It is impossible
to get both intervals to be beatless at once throughout the scale. You should find that in the vicinity of the
transition you have other criteria for a good tuning (such as 4:2 single octaves) and those criteria will be satisfied
quite well. The criteria for a good tuning that we suggested here are just a starting point. Some TuneLab users
report getting better results by selecting 4:2 octaves in the treble. Feel free to experiment to find the settings
that most closely correspond to your tuning style.
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Saving the Tuning File
After the tuning curve has been adjusted to your satisfaction, exit from the tuning curve adjuster by pressing
ESC or click the X button. If you want to save this tuning file for later recall, now would be a good time to do
so. Save the tuning file by clicking on the Save Tuning File button
in the toolbar and entering the name of
the tuning file. Use a name that is short enough to fit in the space allotted in the current settings box but long
enough to remind you which particular piano this is so that you can recognize it in a list of other tuning files. If
you are tuning a lot of new pianos of the same brand, you may decide to keep one tuning file that you use for
all pianos of a particular model. If you have the time, it is best to measure inharmonicity and adjust a tuning
curve for each piano. However new pianos of the same model do not vary that much and for all but the most
critical uses, a generic tuning may be acceptable. You can delete tuning files from the Open File box using the
right mouse button. See Chapter 1 for information on organizing your tuning files into different folders. After
saving a tuning file, you can enter comments about this tuning from the View menu. The comments will be
placed into a text file with the same name as the tuning file.
Beginning to Tune
Because aural tuning always starts by setting a temperament, aural tuning sequences start in the middle of the
scale and work downwards and upwards from there. When tuning to a calculated TuneLab tuning file, you can
tune in any order that you want. Although you may not be considering a pitch raise at this time, remember that
you will get less interaction between notes if you tune from the low bass to the high treble in order. That is the
recommended sequence.
If tuning the bass first, select A0. Play the A0 on the piano and watch for a peak on the spectrum display. The
bass requires some special consideration. Because you are tuning to a high partial, it is quite easy for a wrong
partial to masquerade as the correct partial if the note is seriously mis-tuned. When in doubt, use aural methods
to verify that the note is at least in the ballpark before trusting the spectrum display or the phase display. If you
do not see a very prominent peak in the spectrum display, it is not necessarily a cause for concern. The phase
display will work even with partials that are almost too small to see in the spectrum display. Especially in the
bass, feel free to select a different partial on the fly if you are having trouble getting a reasonable indication on
the current partial. You can press Function keys F3 or F4 to change the partial. If you have enabled auto
partial selection in Edit Options, TuneLab will search for a stronger partial as you tune and switch to that
stronger partial automatically if one is found.
We recommend that for your very first tuning with TuneLab you leave auto note switching disabled. That way
you will not be confused by unintentional note switches. Later on, you can enable auto note switching to speed
up your tuning. For now you can manually switch notes by pressing the arrow keys.
When you finish the monochord section of the bass and come to the bichords, always mute one of the strings
before tuning the other string in the unison. After one string is tuned, remove the mute and tune the unison
aurally. There are times when machine tuning of the unisons is an advantage, but those instances are usually in
the high treble. In the bass there are many partials that need to be balanced. Tuning these unisons aurally
allows you to make the needed compromises to get the best-sounding unisons. Also, aural unison tuning is
faster than using the machine.

14

Proceed up through the bi-chords and into the tri-chords. Here you can mute the outside two strings and tune
the middle string. Then move the right mute over one note to expose the right-hand unison. Tune that unison
aurally and then move the left-hand mute over one note. That will expose the left-hand unison and also remute the right-hand string. In case your right-hand unison was off at all, it is better to tune the left-hand unison
to the middle string than to tune the left-hand unison to the combination of the middle and right-hand strings
sounding at once. Also, having all three strings sound at once increases your chances of having to deal with
false beats. So always tuning unison strings in pairs is recommended.
Continue tuning through the high treble. Here you may have some trouble with the phase display. Even
though TuneLab has artificially slowed down the movement of the phase display in the high treble, false beats
together with a short sustain can produce a confusing picture in the phase display. It is here that we
recommend that you switch over to using the spectrum display. The resolution of the spectrum display is in
term of cycles per second, not in terms of cents. Therefore the cents-wise resolution of the spectrum display
gets better and better the higher you go in frequency. You can see this by noting the jagged look of the
spectrum display around A-440 in the picture in Chapter 1 as compared to the somewhat more precise look of
the graph following that one which is based around C7 (at about 2100 Hz). Therefore, in the high treble we
recommend just trying to get the peak to be centered on the central red line in the spectrum display.
Using Auto Note Switching
You can use auto note switching to make tuning easier. To enable this feature hold the Shift key and press the
appropriate Arrow keys. When auto note switching is enabled, TuneLab will be constantly listening for nearby
notes; and when it hears one, it will switch to it. Auto note switching can be enabled for switching up, down,
or in both directions. The range of auto note switching is up to 300 cents from the current note. If you use
aural checks while tuning, be aware that auto note switching may occur while you are doing these checks. If an
unintended auto note switch occurs, simply use the arrow keys to return to the correct note.
When higher treble notes are selected, auto note switching requires a “trigger”, which is a sudden rise in
volume, such as you would get when playing a note after some silence. At other times, auto note switching is
less demanding, and will switch when the pitch changes without a trigger event. If TuneLab doesn’t switch
when you want it to, wait for some silence, and then play the note again.
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Chapter

The Tuning Curve

The tuning curve is the source of the “Template Stretch” offsets that appear on the main tuning screen. The
tuning curve determines how much stretch there is in the bass and the treble. You do not need to look at the
tuning curve if you are using a saved tuning file, or if you are using automatic tuning curve adjustment. But it is
advisable to take a look at it when making a new tuning just to confirm that the automatic adjustment is
reasonable. You will certainly need to look at it to make manual or semi-automatic adjustments. Also, you will
need to visit the tuning curve adjuster if you want to change which intervals are used to adjust the bass and
treble portions of the curve, as described later in this chapter.
If the tuning curve adjuster is configured for automatic adjustment, then the tuning curve will be adjusted
automatically after every inharmonicity measurement, using the bass and treble intervals you have selected.
Therefore you can just start tuning after making the final inharmonicity measurement for a new tuning. The
rest of this chapter will describe what aspects of the tuning curve can be adjusted and how to accomplish those
adjustments.
Tuning Curve Variations
The tuning curve is adjustable in four different ways, as illustrated here:

over-all treble stretch

over-all bass stretch

treble shape

bass shape

Each of these graphs shows the stretch for all the notes from A0 to C8. The first graph shows three variations
of a tuning curve where the thing that is being adjusted is the overall stretch in the treble. The second graph
shows three variations of a tuning curve where the thing that is being adjusted is the overall stretch in the bass.
The third graph shows variations of the shape of the tuning curve in the treble. The overall stretch at C8
remains the same, but the way in which it gets there is different. One graph shows a stretch that gradually
increases as you approach C8. Another shows a stretch that goes up very little at first, and then abruptly goes
up to the same value for C8 as before. And yet another variation is midway between these two extremes. Of
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course there are infinitely many such variations, but these few have been presented to illustrate the kind of
variation we are talking about. And finally the fourth graph shows variations in the shape of the bass portion of
the tuning curve.
Every tuning curve generated by TuneLab is some combination of these fours kinds of variations or
adjustments. So it is not surprising that in manual adjustment mode, you have four different adjustments that
you can make. Here is what the top part of the tuning curve adjustment screen looks like in each adjustment
mode:

FULLY AUTOMATIC

SEMI-AUTOMATIC

MANUAL

Notice that these graphs have breaks and do not appear continuous. These breaks represent places where the
tuning switches to a different partial. The jumps in the tuning curve are necessary to compensate for the fact
that different partials are being used. The jumps in the curve do not represent actual jumps in the tuning,
which is in fact still continuous.
In the manual mode there are four green bands in the
background. Clicking and dragging the mouse up or
down in those bands will adjust one of the four aspects
of the tuning curve. The left-most and right-most bands
adjust the overall stretch in the bass and the treble. The
middle two bands adjust the shape of the tuning curve in
the bass and the treble. This kind of adjustment gives the
most flexibility, but it is the most tedious, especially if you don't know what you want to do to the tuning curve.
It is preserved for historical reasons, but is hardly ever
used. In semi-automatic mode only the inner two
adjustment bands are active. That is because the overall
stretch in the bass and the treble is being adjusted
automatically, so the outside green bands that control
those adjustments are removed. As with full manual
mode, you adjust the shape of the tuning curve by
clicking and dragging up or down in the appropriate
green band. In the semi-automatic mode, TuneLab will adjust the overall stretch to make the deviation curve
(described below) average near to zero at A0 and C8.
The fully automatic mode shows a solid green background. In this mode, just one click anywhere in that
background will cause all four aspects of the tuning curve to be adjusted automatically. As with semi-automatic
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mode, TuneLab will adjust the tuning curve overall stretch to make the deviation curve read near zero at the
low and high extremes of the scale. In addition it will adjust the shape of the tuning curve to make the
deviation curve as flat as possible in the vicinity of the ends of the scale.
You can select between fully automatic, semi-automatic, and manual adjustment modes by clicking on one of
the mode selection buttons shown here:

Deviation Curve
In order to understand how the tuning
curve is adjusted automatically or manually
we first have to examine the deviation curve,
which is the graph shown below the tuning
curve. The deviation curve is divided into a
left and a right portion. The left portion
shows the effect of the tuning on the
interval selected for the bass, and the right
portion shows the effect on the interval selected for the treble. The bass and treble intervals are selected from
the two drop-down boxes in the upper corners of the graph. This particular display indicates that the treble
interval is the 4:1 double octave, and the bass interval is the 6:3 single octave.
Using the intervals shown (4:1 and 6:3), the left portion of the deviation curve would show how wide or narrow
the 6:3 octaves are in the bass. A positive number of cents means wide and a negative number means narrow.
In the bass portion, each interval is specified in the graph by the left-most note in that interval. So for example,
the left-most portion of the deviation curve says how wide or narrow is the 6:3 octave formed by A0 and A1.
Similarly, the right portion of the deviation curve would show how wide or narrow the 4:1 double octaves are
in the treble. In this case, each interval is specified by the right-most note of that interval. Therefore the rightmost portion of the deviation curve says how wide or narrow is the 4:1 double octave formed by C6 and C8.
Common selections for bass and treble intervals will generally give these results:
●

6:3 in the bass = low to moderate bass stretch

●

8:4 in the bass = higher bass stretch

●

4:1 in the treble = moderate treble stretch

●

4:2 in the treble = higher treble stretch

●

2:1 in the treble = low treble stretch

The graph shown above is the deviation curve for a particular piano and tuning curve. The selected intervals
were 6:3 in the bass and 4:1 in the treble. It was adjusted in the fully automatic adjustment mode. As we said
before, this causes the deviation curve to be near zero at the extreme ends of the scale and to be as flat as
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possible in the vicinity of those extremes. In this case we see that is so. Reading from that graph we can see
that for this particular tuning of this particular piano:
●

The 6:3 octave A0-A1 is wide by about 0.6 cents

●

The 6:3 octave C#1-C#2 is nearly perfect

●

The 6:3 octave F1-F2 is narrow by about 0.2 cents

●

The 6:3 octave C3-C4 is about 2.6 cents wide

●

The 6:3 octave C#4-C#5 is narrow by about 0.4 cents

●

The 4:1 double octave D2-D4 is about 2.5 cents wide

●

The 4:1 double octave G4-G6 is nearly perfect

●

The 4:1 double octave C6-C8 is about 1.3 cents wide

To read the deviation curve properly, remember that every interval is composed of two notes and the
deviation curve reports the condition of that interval on the graph. But the graph shows the condition of that
interval for either the upper or lower note in the interval. In the treble section of the deviation curve the note
chosen to represent the interval is the upper note, but in the bass section the note chosen to represent the
interval is the lower note. So for every point on the graph, imagine an interval that extends from that point to
the right or to the left depending on which half of the deviation curve you are in.
Now let's explore the deviation curve
further. Without changing the tuning curve
adjustment, we can select the 4:2 octave in
the treble in place of the 4:1 double octave.
If we did that, the deviation curve would
become the graph as shown here on the left.
The graph zoom has been changed to
contain the very low value at C8. When the
4:1 interval is changed to the 4:2 interval the tuning does not change. The tuning is still the same, but the
deviation curve changed because it is now reporting a different interval in the treble. (Notice that the bass
portion of the deviation curve remained the same, since it is still reporting the 6:3 interval.) But looking at the
4:2 interval we see that its tuning has a perfect 4:2 octave at D#4-D#5. This is actually quite good because the
fourth octave is normally tuned with perfect 4:2 octaves when tuning aurally. But 4:2 octaves are not used for
aural tuning in the high treble because the partials involved are too weak to cause much of a beat. So we
should not be upset at seeing such narrow 4:2 octaves being reported in the high end of the deviation curve.
Now suppose we force an automatic adjustment of the tuning curve based on this new interval selection (by
clicking on the tuning curve when the background is all green). Then the deviation curve would look like the
one shown below. As before, when we do an auto-adjust the selected intervals are forced to come out nearly
beatless near A0 and C8. Adjusting with 4:2 in the treble generally produces more stretch than with 4:1 in the
treble. In the example that generated these graphs, C8 was stretched by 31.64 cents when the 4:1 interval was
selected for the adjustment. But C8 was stretched by 48.31 cents when the 4:2 interval was used as the basis of
the adjustment instead.
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Now that we have adjusted the tuning curve
based on the 4:2 intervals, let's go back and
see how the 4:1 interval would turn out with
this adjustment. The graph shown here
shows that the 4:1 interval would be
generally much wider everywhere, especially
in the high treble. Compare this graph to
the one on the previous page to see how
well- behaved the 4:1 double octave was when it was used for the adjustment.
So what we see is that tuning is a compromise between competing intervals. Personal preference determines
which intervals are most important at which parts of the scale. As you can see, there are many possible ways to
adjust the tuning curve even if you use the fully automatic adjustment mode. And after an adjustment has been
made, you can temporarily select a different interval just to see how that interval would work out with the
current tuning curve adjustment. We recommend that at first you simply select 6:3 in the bass and 4:1 in the
treble and do an adjustment in automatic mode and use it. If you prefer more stretch in the bass, use the 8:4
octave instead of the 6:3. If you want more stretch in the treble, use the 4:2 octave instead of the 4:1 double
octave.
Displaying Beats in the Deviation Curve
The deviation curve normally shows the condition of the selected intervals in cents. But you can also show
beats. To switch to showing beats in the deviation curve, check the appropriate item in the options shown with
the OPT button.
Displaying the Tuning Curve for All Fundamentals
Normally the tuning curve is shown for whatever partials are selected for each note. But if you want to see
what the tuning curve would look like if every note were tuned to the fundamental, there is an option for that
by using the OPT button.
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Chapter

All About Offsets

TuneLab uses various offsets. The offsets are all displayed in cents on the right side of the Current Settings box
as shown in Chapter 1. TuneLab combines them to calculate the desired pitch for each note. In normal
tuning only the template tuning curve offset is present and the other offsets are all zero. The overall offset and
the custom stretch offsets can be entered
numerically using the Enter Offsets menu
item, or by pressing F6. In the window
shown here the entry in the upper left is the
overall offset which affects all notes equally.
This is the offset you would use to shift the
entire scale to some non-standard pitch, like
A-435. Instead of entering the offset in
cents you can let TuneLab calculate the
offset for you by entering what pitch you
would like for A4 (instead of 440). Just
enter the desired pitch in the next box and TuneLab will make the offset be whatever is needed to achieve that
pitch.
There are also optional custom stretch offsets for each note individually. Normally all these custom stretch
values are zero. But for special uses you can establish a custom additional offset for any note. You can fill in
the box shown above for the “Custom Stretch for..” for whatever note is currently selected. Or you can click
on “Examine/Edit all Custom Stretch Values” and see and edit all 88 of these custom stretch values at once.
Working with the Overall Offset
In addition to entering the overall offset numerically, you can also modify the offset with either the keyboard or
the mouse. To use the mouse just click and drag right or left through the phase display. Dragging to the right
raises the offset and dragging to the left lowers it.
For compatibility with older versions of TuneLab you can also use the keyboard to adjust
the overall offset. Just observe the mapping shown to the left. You can adjust the offset
using the keyboard keys Y, U, I, and O to raise the offset by +10, +1, +.1, and +.01.
Similarly, the keyboard keys H, J, K, and L may be used to lower the offset by -10, -1,
-.1, and -.01. The Z key will set this offset to zero. The overall offset can also be
affected by Locking mode, which is described later in this chapter.
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Custom Stretch
This is an optional note-by-note offset and it is stored in the tuning file. It is rarely used, except when recording
an aural tuning for the Tuning Exam. It can be used to make note-by-note corrections to the tuning curve.
But if you find yourself making many such corrections, then you should consider readjusting the whole tuning
curve instead. This custom stretch can be set by a transfer from the overall offset as described above. This
offset is not displayed if it is zero.
Template (Tuning Curve) Stretch
For each note, this offset comes from the tuning curve. It is calculated based on the adjustment of the whole
tuning curve, taking into account the partial that is selected and the inharmonicity. It is normally calculated
automatically, but it can also be manually adjusted by adjusting the entire tuning curve.
Temperament Offset
This offset is shown only when an unequal (historical) temperament is selected. In that case, this offset shows
the temperament offset for the current note, which is the same for all other notes of the same name in different
octaves. The 12 temperament offsets are stored in the tuning file when it is saved with an unequal
temperament selected.
Locking Mode
Locking mode is entered by clicking on the Lock button
or by pressing the period (“.”) key. The left
status box will appear indicating the Locking mode. To cancel locking mode, click on the Lock button again or
press the ESC key. When Locking mode is active, the offset is automatically adjusted by TuneLab to make the
phase display come to a complete stop. The adjustment starts by making large rapid changes in the offset,
which gradually reduce to small slow changes after a few seconds. This behavior allows quick initial locking,
followed by more precise offset trimming as the feedback is gradually reduced. At any time during the locking
operation the feedback can be set to maximum by pressing the period key again. A form of Locking mode is
also used whenever you perform a calibration as described in the chapter on calibration.
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Chapter

Over-pull (Pitch Raise) Tuning Procedure

Over-pull tuning is most often used in pitch raising, although it could also be used for pitch-lowering. When
large overall changes are made to the tuning of a piano, the notes that you tune tend to change pitch as you
tune later notes. Over-pull tuning mode compensates for this change by setting the pitch targets a calculated
amount beyond the desired pitch. In this way the settling that occurs as later notes are tuned will leave the
notes closer to where you ultimately want them to be. In many cases using just one pass with over-pull tuning
can take the place of tuning the piano twice. And even if you do use two passes, doing the first pass in overpull mode will leave the piano closer to the correct pitch than if you hadn't used that mode, and thus the
second pass will be easier.
Measuring Inharmonicity Before an Over-pull
When over-pull mode is activated TuneLab will not let you measure inharmonicity. Therefore if you want to
create a custom tuning for the piano as described in Chapter 2, you would have to measure the inharmonicity
before enabling over-pull mode. For small pitch raises the normal inharmonicity measurements will be
sufficient. However for larger pitch raises, the act of pulling the string up to pitch will change the inharmonicity
of the strings. For such pitch raises it is not worthwhile to measure inharmonicity first. Just load the Average
tuning file (which comes packaged with TuneLab), or a generic tuning file from a similar model piano. Then
do a pitch-raise pass using that tuning. When you do the second pass, start over with a new tuning file and take
fresh inharmonicity readings. Only the final pass would need to have custom inharmonicity measurements
taken.
Enabling Over-pull Mode
Over-pull has two phases. The first phase is pre-measuring the piano. No tuning is done in this phase. We
simply let TuneLab hear a set of notes from the piano and gather some pitch information about those notes.
In the second phase we do the actual tuning which includes over-pull offsets that TuneLab calculates from the
data gathered in the first phase of over-pull. If your evaluation of the piano convinces you that the overall pitch
change is large enough to need an over-pull, you can begin the process of over-pull tuning by pre-measuring
the piano. This must be done before any tuning has been started, in order to get an accurate measure of how
flat the piano was to start with. This will enable TuneLab to calculate an amount of over-pull appropriate to
the particular piano. To start, stop, or change any parameters relating to over-pull, use the Over-pull
Mode menu item, or click on the Over-pull toolbar button shown here, or press the F2 function key.
This will display the window shown below.
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You can click on Start to start
the pre-measuring process
from the beginning. Or you
can click on Resume to start
pre-measuring
at
the
currently selected note,
keeping all previous premeasurement values. After
the pre-measurements all
have been taken you can click
on Begin over-pull tuning to
start the actual tuning with
over-pull offsets calculated
and added in for you based
on the pre-measurements
that were taken. As a general
rule of thumb, the calculated
over-pull offsets are about one quarter of the average pre-measurement value. So if the piano was 50 cents flat,
over-pull tuning will set target pitches that are about 12 cents sharper than normal. This is only an
approximation because TuneLab uses the entire set of pre-measurements in a proprietary manner to calculate
the over-pull offsets. You can choose the pattern of pre-measurements. You can select Every note (chromatic
series), Every white note, or All notes in a C-Major arpeggio. Since TuneLab interpolates between the notes that
you do pre-measure, it is not necessary to pre-measure every note.
The rest of the window has to do with options that you can use with the over-pull process. The first over-pull
options are the location of the break between the bass bridge and the tenor bridge and the break between
wound strings and plain strings. Clicking on any selection will allow you to change it. TuneLab uses this
information in the calculation of the over-pull offset, as well as to qualify the next options - the safety limits.
The next two options are safety limits. They set an overriding upper limit on how high the over-pull offset can
go. For example, if the pre-measurements showed that the piano was about 180 cents flat, the calculated overpull would have been about 45 cents sharp. But this is above the specified safety limit of 25 cents, so the overpull offset was limited to 25 cents. You can set these safety limits to whatever you want by clicking on the
setting. But you take all responsibility for what may happen with higher safety limits. TuneLab initially is
installed with the most conservative limits in effect. If you want more permissive limits, then you will have to
change them. When the TuneLab over-pull offset is being limited by a safety limit, that offset will be displayed
with a pink background to let you know that you have hit a safety limit. If this is expected then just continue
tuning. You will probably need to do an extra pass, but you would want to do that anyway to lessen the chance
of breaking strings. On the other hand if you think the strings can take it, raise the safety limit to a higher value
to cause this piano to be brought up to pitch more quickly.
You can optionally specify the location of one or two plate struts in the treble. If specified, this information will
help to prevent a pitch-raise from ending up too sharp just after a strut. The over-pull factor should normally
be left at 1.00. It multiplies all the calculated over-pull amounts by this factor.
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You will also be able to delete pre-measurements that you decide are faulty. If you delete a pre-measurement,
TuneLab will simply interpolate between the neighboring pre-measurements to calculate the over-pull offset.
Sampling every note sometimes gives a more accurate picture of the pre-tuned state of the piano, but it also
takes four times longer than sampling only the notes from a C-arpeggio. If you think the piano is close to being
in tune with itself, then sampling only the C-arpeggio notes probably is sufficient, and that is in fact the default.
Sometimes something goes wrong with a pre-measurement. You might play the wrong note, or TuneLab
might get triggered by some non-piano sound and make a faulty measurement. That is why each premeasurement is displayed as it is taken. If you suspect that a faulty pre-measurement has been made then you
either redo the set of pre-measurements from the beginning, or you can click on View/Edit pre-measurements and
see if any pre-measurements appear unreasonable. If so, you can delete the faulty measurements and then
proceed to tuning in over-pull mode. As before TuneLab will interpolate over the missing pre-measurements
using the nearby good pre-measurements.
Pre-measuring Process
When starting the pre-measurement process it is important to have some reasonable tuning loaded first. That is
because the pre-measurements will evaluate the pitch of the piano by comparison to whatever tuning is
currently loaded. However it is often sufficient to load the Average tuning, or some generic tuning from
another piano to use in a pitch-raise, since it is difficult to customize a tuning while the piano is significantly flat.
So if you have a reasonable tuning loaded, start the premeasurements by clicking on the Over-pull button as
described above and then on Begin pre-measuring. This will
display the status boxes shown here, instructing you to play
C1 or A0, depending on the pre-measure pattern you have selected. When you play C1, TuneLab will do a
quick one-second pitch measurement for C1 and then the right status box will change to the
one shown here. This shows the results of the pre-measurement of C1 (-24 cents) and gives
instructions for the next note to play in the pre-measure sequence. So now you would play E1
and then TuneLab will automatically switch to E1 and make the pre-measurement. Note that this is not the
same thing as auto note switching during ordinary tuning. During pre-measuring, TuneLab will switch to the
next note whenever a moderately loud sound is heard. So it is up to you to ensure that TuneLab hears the note
that it expects to hear. Normally you would run through all the notes in the pre-measure sequence in about
half a minute. But if you and TuneLab should somehow get out of sync and you play a different note from the
one that TuneLab is instructing you to play, the pre-measurements obtained that way will be invalid. If this
happens there are several ways you can correct the situation. The easiest way is to start over and re-do all the
pre-measurements from scratch. Or if you like, you can manually select a note and then select Resume premeasuring from the Over-pull window. This will begin pre-measuring wherever you want. Or after the premeasurements are done you can review the pre-measurements from the Over-pull window and manually delete
those pre-measurements that you suspect are faulty. TuneLab will smoothly interpolate across any missing premeasurements.
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Over-pull Tuning
After the last note in the pre-measure pattern has been measured, TuneLab automatically will switch to the
tuning phase of Over-pull by switching to A0 and displaying
status boxes like the ones shown here. The left status box
indicates that we are now in the tuning phase and the right
status box tells us how much over-pull is affecting the current note (A0 in this case). Comparing with the premeasurement made for A0 previously, which was -24 cents, you can see that the over-pull amount is more than
the rule-of-thumb one quarter of the pre-measured pitch. But that is because for this particular tuning the premeasurements for notes after A0 were flatter than A0. In more extreme pitch-raises it is likely that you will hit
your safety limits. If you should hit a safety limit, the overpull amount will be limited by that safety limit and the right
status box will indicate that it is limited by displaying the
over-pull amount with a pink background as seen here. In
this case 25 cents was previously set at the safety limit.
You can also switch to the tuning phase before all pre-measurements have been made. Just go to the over-pull
window and click on Begin over-pull tuning.
You may now tune the piano normally, except that you should tune straight from A0 to C8, tuning unisons as
you go, and each note will have an over-pull offset added on to it. You should tune unisons as you go because
TuneLab assumes that you do that when it calculates the over-pull offset.
You can turn off over-pull mode by going to the Over-pull window again and clicking on Stop using over-pull.
How Over-pull is Calculated
You do not need to understand the exact formula for over-pull to take advantage of over-pull mode. TuneLab
performs the calculation automatically based on all the pre-measurements, and on the setting of the over-pull
parameters. There is no longer any concept of an over-pull percentage, as found on earlier versions of
TuneLab. Nor is there a running average of pre-measurements done during tuning. Instead, each individual
pre-measurement contributes to each individual over-pull amount with a proprietary formula. This means you
do not have to worry about pre-measurements while you are tuning, nor do you have to worry about auto note
switching interfering with pre-measurements. If a note is too far off pitch to trigger auto note switching, just
start tuning it near its correct pitch and TuneLab will switch to it when it comes into range of the correct pitch.
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Chapter

Calibration Procedure

Chapter 1 described the purpose of calibration. This chapter takes you through the process of actually doing a
calibration. Normally you would only do a calibration only once when you first install TuneLab on your
computer. The results of the calibration are stored permanently and used every time you run TuneLab.
Internet Calibration
One of the ways to calibrate is by way of Internet Time Servers. As with any calibration method, it normally
only needs to be done once. TuneLab stores the calibration and uses it thereafter.
The Internet Calibration first appears like this:
As the instructions say, the process takes up
to six hours, but it can be performed
unattended. After clicking on "Begin
Calibration", TuneLab will query up to four
Internet Time Servers to establish a precise
time for the start of the operation. During
the six hours, the software is counting audio
samples from the sound system to determine
the sampling rate, which is the goal of any
calibration. After about one minute, the
display looks like the next picture.
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The results of the Time Server queries is
shown at the bottom. The round-trip time is
the time between TuneLab sending out the
query and the time when the Time Server
responds. The shorter the round-trip time
the better. Anything less than 0.200 seconds
is usable. At this point you can leave the
program alone and it will complete
automatically after six hours. There is a
countdown clock at the top of this box telling
you how far along you are in that process.
The button that says "Try early completion"
lets you complete the calibration at some
time before the full six hours is up. The
button also shows how accurate the
calibration will be if you do try to complete
the calibration early. In the example shown,
the accuracy would be 0.82 cents, which is really quite poor. That is because only one minute has gone
by. As more time goes by, this accuracy number in the button will be updated. After about 20 minutes
the example shown here would show 0.08 cents. This is a ten-fold improvement, but still not as good as
it could be. These accuracy estimates are also based on the average round-trip time for the time queries.
If those times are longer, the accuracy estimates will be correspondingly worse. So you may not get to
within 0.08 cents in 20 minutes with your Internet service. We recommend that you simply let the
calibration run for the full six hours. Then the accuracy estimate for most Internet service will be less
than 0.02 cents, which is as good as you can expect from any tuning device.
After the six hours is up, or after you complete the calibration early, TuneLab will make a few more time
measurements of the audio samples and then do another set of up to four queries of the Internet Time
Servers. Based on all the measurements taken, TuneLab will calculate the actual audio sample rate and
store it the same as if you had done a calibration some other way.
A Trusted Source of Pitch
Internet Calibration uses a trusted source of time. Any other method of calibration uses a trusted source of
pitch. The most accurate source of pitch that you can get is the National Institute of Standards and
Technology (NIST). This agency of the U.S. government has a telephone service and shortwave radio service
that disseminate standard time and frequency. The telephone service is free of charge (except for the usual
phone charges – it is not a toll-free number), and the shortwave radio service may be heard on 2.5, 5, 10, 15,
and 20 MHz, if you have a shortwave radio. Another source of accurate pitch is some other calibrated tuning
device that can produce a tone. Finally you can check your calibration against high-quality electronic keyboard
instruments that are normally set at the factory to exactly A-440 for A4. If you use this source be sure to check
several keyboards to confirm consistency. Do not try to use any tones from websites on the Internet for a
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calibration reference. The pitch from such sites is only as accurate as the sound card in your computer,
which could be off by quite a bit.
NIST Broadcast (and Telephone) Schedule
The NIST standard frequency service is available by telephone by calling (303) 499-7111 in Colorado. This is a
very popular number. What you hear when you call this number is exactly the same as what is being
transmitted by the NIST shortwave radio stations as mentioned above. NIST reports that they get over two
million calls per year. In order to use these services effectively, you need to know something about the
schedule for this service. The following schedule is followed each hour. It shows what tones are present
during each minute of the hour. When a tone is present, it is present for the first 45 seconds of the minute and
it is silent for the last 15 seconds.
0:
1:
2:
3:
4:
5:
6:
7:
8:
9:

--600
440
----600
500
600
-----

10:
11:
12:
13:
14:
15:
16:
17:
18:
19:

--600
500
600
------600
--600

20:
21:
22:
23:
24:
25:
26:
27:
28:
29:

500
600
500
600
500
600
500
600
500
---

30:
31:
32:
33:
34:
35:
36:
37:
38:
39:

--600
500
600
500
600
500
600
500
600

40:
41:
42:
43:
44:
45:
46:
47:
48:
49:

500
600
500
---------------

50:
51:
52:
53:
54:
55:
56:
57:
58:
59:

----500
600
500
600
500
600
500
---

Although the 440 Hz tone in minute #2 is tempting, do not try to use it. That pitch is only present for 45
seconds each hour. The difficulty in calling at just the right time and the shortness of the tone make this choice
inadvisable. Instead you can use the 500 Hz and 600 Hz tones. The telephone service will disconnect you after
three minutes, so make sure that when you call you have everything set up and time your call so that you will be
assured of at least three minutes of 500 Hz or 600 Hz tones. If you happen to be closer to Hawaii than to
Colorado, you can receive WWVH by shortwave radio or by calling (808) 335-4363 in Hawaii. For more
information on both of these sources, see the website:
www.boulder.nist.gov/timefreq/stations/iform.html

Using NIST Tones for Calibration
To use the NIST standard frequency service to do a calibration, start by selecting Calibrate to External
Reference from the File menu. Then select 500 or 600 Hz NIST tones as the reference source. Do not try to
make the call to the NIST using Skype or any such Internet phone service. Use a landline or standard
cellphone. Internet phone services can slightly distort the pitch of the sound. Position the receiver of the
phone so it can be heard by your computer's microphone. Follow the on-screen instructions. TuneLab will
automatically determine which tone is currently sounding (500 or 600) and lock to it. When TuneLab has
heard enough it will display a message saying that calibration is done.
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Using Other References for Calibration
Besides the 500 and 600 Hz NIST tones, TuneLab offers other choices. If you have a precise 440 or 1760 Hz
tone source, you can use that. 1760 Hz was chosen because it is the fourth harmonic of 440 Hz. Finally, there
is a completely general choice where you can enter whatever frequency you like. But whatever frequency you
enter, it must be the true frequency of the source that you intend to use for calibration. If you have a calibrated
CyberFork (from Reyburn Piano Services) then you can use it as a calibration source by entering the exact pitch
in Hz. The exact pitch of a CyberFork is offset from 440 by the amount written on the CyberFork. The offset
on the CyberFork is in cents, so you first need to convert that to Hz. You can use TuneLab to do that by
selecting A4 (440 Hz) and then adjusting the offset, as described in the chapter “All About Offsets”. Adjust the
offset until it matches the offset written on the CyberFork, then read the frequency in Hz from the lower left of
the current settings box. It should be near 440. For example, if the CyberFork says -0.56 cents, then the
frequency of that CyberFork is 439.858 Hz. If you want to use that CyberFork to calibrate TuneLab, that is the
exact frequency you should enter.
If you want to use a high-quality electronic keyboard instrument to calibrate TuneLab and if that instrument has
selectable voices, select a flute or simple pipe organ voice without any vibrato. Play A4, assuming that the
instrument has been trimmed at the factory to exactly A-440. If you are in doubt about the reliability of that
pitch source then after calibrating, check the A4 of several other electronic keyboards. If they are all in general
agreement, you can be fairly confident that you have performed a good calibration.
Stopping Calibration
If a calibration is not completing automatically this usually means something is wrong with the setup or the
sound being provided to the microphone. You can stop (abort) calibration at any time by pressing the ESC key
or by clicking in the left status box that says “Calibrating..”.
Verifying Calibration
After a calibration is complete, you may wonder if it completed properly. You can check this in several ways.
From the Help menu, select About. A box will appear that shows, among other things, the actual sample rate.
This is the actual end product of doing a calibration. The actual sample rate is stored in your computer to be
used every time you start up TuneLab. If you are curious as to how far off TuneLab would have been without
calibration, compare the actual sample rate shown in the About box with the nominal sample, which is 22,050.
Now that you have done a calibration, it will not matter that the actual sample rate is different from the
nominal rate because TuneLab knows about the difference, and is taking it into account in all its calculations.
Another way to check calibration is to go back to NIST or some other trusted source of known pitch. Select
the note and offset that make the phase display stand still. If TuneLab is properly calibrated, the frequency
display in the current settings box should be absolutely accurate and it should agree with the frequency of the
trusted source.
Calibrating Sound Generation
When you calibrate the listening mode as described above, TuneLab assumes that same calibration will apply to
sound-generating mode too. That assumption is generally true. But in some computers the sound generating
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(the speaker) is based on a separate crystal oscillator from the one that runs the listening mode (the
microphone). That means it is possible for the listening mode and the sound generating mode to require
different calibrations. If you would like to ensure that generated tones are just as precise as the listening mode,
you should calibrate the sound generating mode as well.
The calibration of the sound generating mode is based on the calibration of the listening mode as described
above. What we do is generate a tone and have the microphone of that same computer listen to that tone.
Then TuneLab will be able to determine a precise calibration for sound generating mode.
From the File menu select Calibration / Calibrate Sound Gen from Listen Mode. After clicking on Start you will see
a window like the one shown on the left. At the same time you should hear a tone in the speaker. When

the microphone hears that tone, the message will switch to “Initializing...” and then to a message like the one
on the right, showing a percentage done. This percentage will count up to 100% in about half a minute and
then the calibration will be done. If the sound is interrupted or if there is excessive noise before the calibration
can complete, the message may go back to “Initializing..” or even “Waiting for microphone to hear tone from
speaker.” But if the tone is heard clearly by the microphone, the calibration will complete with a message
telling you that it is completed successfully.
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Chapter

Historical Temperaments

TuneLab normally produces an equal temperament. But historically, equal temperament was not always the
norm. Even today there is a strong interest in non-equal temperaments. With a non-equal temperament,
different key signatures have different musical characteristics. It is said that the classical composers were aware
of these differences and wrote their music to take advantage of these differences. A full treatment of historical
temperaments and their musical characteristics and advantages and disadvantages is beyond the scope of this
manual. But if you are interested, there is a lot of literature on this subject.
For our purposes an historical temperament is defined by a set of 12 offsets from equal temperament. These
12 offsets are repeated in every octave. TuneLab comes packaged with a set of historical temperaments that
can be applied to any tuning file. If you know of an historical temperament that is not included with TuneLab,
it is easy to add that temperament to your computer by entering the 12 offsets, as described below.
Loading Temperament Files
To add an historical temperament to the current tuning, click on Read Temperament File in the File menu, or
press the F5 function key. If you see a temperament that you want to use, just open it. If you have an historical
temperament applied and would like to remove it from the current tuning, click on Cancel temperament in the
File menu. This will return your tuning to Equal Temperament.
When an historical temperament has been added to the current tuning, you will see the name of that
temperament just below the tuning file name on the main tuning page. Also you will see an offset for each note
showing as Temperament Offset xx.xx. As you change notes, the temperament offset changes.
Making Temperament Files
If you want to use a temperament that was not provided with TuneLab, you can create your own new
temperament files from the File menu, New..., Unequal Temperament File. At this point you have two choices on
how to make the temperament. One is “..by manually entering offset”. This will show you 12 boxes where you
can enter the 12 offsets that define the temperament. The other choice is “ ..from current Custom Stretch values”.
This choice is useful when you already have tuned a temperament aurally and captured that tuning by locking
TuneLab to each note and transferring the offset into the Custom Stretch values. Then TuneLab asks you to
decide which note will form the basis of the 12 offsets that you wish to capture, as shown below.
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When you select a starting note the Custom Stretch values
for that note and the following 11 notes will fill the boxes
on the left. You can still make manual changes to those
values. To finish, you click on Make temperament file and
give the temperament a name. This will store the 12 offsets
that you entered into a file with the specified file name.

Applying Temperaments
In addition to merely selecting a temperament you can also specify how it is to be applied to your tuning. You
have three choices that you can make from the Edit menu under Edit Options / Temperaments: (1) Normalize
so that the average offset is zero cents. (2) Normalize so that A is always at zero cents. (3) Leave the
temperament offsets just as they are in the temperament file. The reason for normalization #1 is to minimize
the overall impact on tuning stability when changing between equal temperament and an unequal temperament.
Choice #2 may be useful if you want to ensure that the pitch of A does not change.
Finally you can rotate any temperament. From the File menu select Rotate temperament starting note. This will
take the 12 offsets and rotate them so that the offset currently associated with C will instead be associated with
the note that you select. This is useful if you want to apply an historical temperament, but you want to change
which key signatures are “favored” by the given temperament.
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Chapter

Special Functions
Split Scale Mode (especially Spinets)

Many spinets (and some small grands, like the Yamaha GH-1) are difficult to tune because they have a large
jump in their inharmonicity - usually at the point where the scale makes the transition between wound strings
and plain strings. TuneLab has a special facility just for such pianos. This facility is called the "Split Scale".
If you want to use the Split Scale, do this:
1. Take inharmonicity measurements of the two consecutive notes at the transition. (If the
inharmonicity constants from these two measurements are not significantly different from each
other, discard one of the readings and do not use Split Scale mode.)
2. Measure three other notes below the transition.
3. Measure three other notes above the transition.
This pattern of inharmonicity measurements tells TuneLab to use the Split Scale tuning curve, and it also tells
TuneLab exactly where the transition is.
An alternate way to start a Split Scale tuning file is from the New menu. Select “New Split Scale Tuning File”.
TuneLab will then ask you for the location of the break where you expect the inharmonicity to jump (typically
the break between wound strings and bare wire strings). Once TuneLab knows this, it will figure out which
notes you should measure and sequence through those measurements automatically.
After you have measured inharmonicity as described above, you can invoke the tuning curve adjuster. The
tuning curve adjuster shows when TuneLab is in Split Scale mode by placing a vertical line on the tuning curve
and the deviation curve, as shown in the picture below. This vertical line shows the location of the break
between the two parts of the split scale. If you do not see this vertical line in the tuning curve adjuster,
TuneLab is not in Split Scale mode. If you expected to see Split Scale mode, review your list of inharmonicity
readings to see if they follow the correct pattern for Split Scale.
For example, if you are tuning a piano that has a break at F#3/G3, you could invoke Split Scale mode by
measuring inharmonicity at:
B0 G1 E2 F#3 G3 C4 A4 G5
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When TuneLab is in Split Scale mode, the tuning curve adjustments have a direct effect on the portion of the
tuning curve above the transition. We recommend that you select 4:1 double octaves in the treble side of the
tuning curve adjuster, and 6:3 single octaves in the bass side. As with normal tuning you can let TuneLab
calculate the tuning after inharmonicity measurements are made. But looking at the tuning curve is useful for
confirming that the calculations went well.

In Split Scale mode, the usual model for the inharmonicity of the whole piano is broken up into two separate
models - one for the portion of the scale below the transition and one for the portion above the transition.
When you adjust the tuning curve, you will be adjusting directly only the portion of the tuning curve above the
transition. The portion of the tuning curve below the transition will be adjusted automatically to give perfect
6:3 single octaves, if 6:3 octaves are what you selected for the bass. If you selected something else for the bass,
then TuneLab will adjust the bass for 6:3 single octaves at the top of the bass and whatever you selected at the
bottom of the bass. TuneLab will blend smoothly between these two intervals as you move down the scale in
the bass. If you select 6:3 single octaves for the bass, then the deviation curve will show exactly zero cents for
the entire left half of the curve. For adjusting the tuning curve in Split Scale mode, we recommend the fully
automatic method of adjustment as shown in the previous picture. The image shown above is what a good
tuning curve and deviation curve might look like in Split Scale mode. Note the vertical line which indicates
Split Scale mode.
The large deviations in the middle of the deviation graph are to be expected. Pianos that need Split Scale mode
tend to have high inharmonicity just above the break. Although 4:1 double octaves in this region may be quite
wide, 4:2 single octaves will be just about right. You can check the condition of 4:2 single octaves by
temporarily switching to 4:2 in the treble. Make sure you switch back to 4:1 double octaves before making any
further adjustments. After you have adjusted the tuning curve so that the deviation curve looks like the one
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above, focus mostly on the far right end of the curve and how it sticks close to zero, then exit from the tuning
curve adjuster and tune the piano as usual.
Tuning Exam Mode
From the Modes menu you can enter or leave Tuning Exam Mode. When this mode is active, the status box
on the right side of the current note display is used to display the total offset, rounded to the nearest 0.1 cents,
in keeping with the requirements of the PTG Tuning Exam. This display may be used to gather tuning offsets
manually. Also, Tuning Exam Mode forces the use of the proper partials, as specified by the PTG Tuning
Exam. In addition, there is a grading facility for comparing an examinee’s tuning with a master tuning. See the
separate document on using TuneLab in the Tuning Exam for details.
Measuring Voicing and Sustain Time
As a by-product of measuring inharmonicity, TuneLab creates a picture of the relative amplitudes of the various
partials that were measured. All the partial amplitudes are rated in proportion to the strongest partial, which is
rated at 100. The voicing display is part of the inharmonicity result display shown in Chapter 2. In that display
you will see two sets of horizontal bar graphs - one white and the other black. The white bars show the
amplitudes for the current measurement. The black bars show the amplitudes for a previously saved
measurement (using the “Save” pushbutton). In the case of the picture in Chapter 2, the previous measurement
was made with a forté blow, and the current measurement was made with a much softer blow. This resulted in
different relative amplitudes, especially for the second partial. Keep in mind the limitations in the use of this
voicing measurement. The exact pattern of amplitudes depends greatly on the quality and the placement of the
microphone, and on the strength of the hammer blow.
Another by-product of an inharmonicity measurement is the sustain time, which is described as the length of
time that a note sounds before fading so much that it cannot be heard. Although this definition is imprecise
and subjective, piano rebuilders often need some measure of sustain time to evaluate the quality of the bridge
and soundboard. The calculated sustain time is shown along with the results of the inharmonicity
measurement. To measure sustain time, follow the normal instructions for measuring inharmonicity.
However, there are several precautions for measuring sustain time.
One precaution is to turn off automatic gain control on the microphone, if your laptop soundcard offers such
an option. Normally, automatic gain control would be a good thing because it brings up the level of the sound
as the note decays, thus giving TuneLab more signal to work with. But automatic gain control will make the
notes appear to sustain much longer than they really do, so the calculation of sustain time will be invalid. If you
do change automatic gain control settings, you will have to switch temporarily to sound generating mode and
back to listening mode for the change to take effect.
Another precaution is to be aware of the sound level as you strike the note. If the level reaches 100% for too
much of the phase of the inharmonicity measurement, then no sustain time will be reported. You can preview
the sound level by looking at the mic level indicator on the main screen. Learn how hard you must strike the
note to achieve an initial 100% level, or thereabouts. A brief period of 100% level is OK as long as the level
drops below 100% shortly thereafter.
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Finally, make sure that the correct note is selected when you measure sustain time. Although the sustain
calculation is not pitch-sensitive, the total sampling time does depend on which note is selected. TuneLab
assumes a shorter sustain for higher notes, as you can see by noting the differences in the inharmonicity
sampling times.
Auto Partial Selection
As stated in Chapter 1, the selection of which partial to use for each note can be modified by editing the table
of partials as a whole, or by making individual on-the-fly changes. Sometimes individual bass strings are found
to be weak in the pre-selected partial, making it difficult to tune them. You could manually try different partials,
or you can let TuneLab change to a different partial by enabling the option for automatic partial selection. This
option can be found under Edit Options. You specify a note below which automatic partial selection may
occur, and how high a partial you will allow to be selected automatically. The default is to disable automatic
partial selection completely. If you select a higher limiting note in your Options, then the lower notes will have
automatic partial selection enabled.
When automatic partial selection is enabled for a note, the partial selection may change during the first few
seconds after you switch to that note. TuneLab will not change partials unless it finds a qualified partial that is
at least twice as strong as the currently selected partial. TuneLab will change partials only once for each note
switch. If an automatic partial change does occur, that change is treated exactly the same as if you had made
the change on the fly manually. In particular, if the Persistent Partials option is enabled, the change is
incorporated immediately into the current tuning file.
Aural Temperament Tuning Sequences
Normally TuneLab sequences from one note to the next in chromatic half-steps. But what if you want to
follow a sequence like those that are used in aural tuning, perhaps as a training aid in learning aural tuning? For
this purpose TuneLab provides aural temperament sequence control.
First, select an aural sequence file by going to the File menu and clicking on Select Aural Tuning Sequence.
An aural sequence is specified by a file that lists the notes contained in the sequence in the order that they
should be seen. The TuneLab installation contains one such file named “4ths and 5ths.txt”, but you can make
others. The aural sequence files are simple text files and they reside in the Aural Sequences folder under the
same folder where you keep your tuning files (usually My Documents\TuneLab Pro). Any text files that you
create and place in this folder will be accessible as an aural sequence file. If you would like to add more aural
temperament sequence files, use Notepad or some other text processor and make a file that lists the notes you
want to include in the sequence in the same format that is used by “4ths and 5ths.txt” and place the new file
into the same Aural Sequences folder.
After you have made a selection, the note switching mode will show “aural sequence” instead of “Auto up”, or
“Manual note”, etc., and the first note in the sequence will be selected automatically. Once TuneLab is in the
aural sequence mode, you can switch to the next note in the sequence by pressing the space bar. You can go
to the previous note in the sequence by pressing the Backspace key. There is no automatic (hands-free) note
switching in aural sequence mode.
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Once an aural sequence has been selected, you can change back to some other note switching mode and return
to aural sequences again later by selecting aural sequence from the Modes menu, or by pressing Cntl-A.
TuneLab remembers the last aural sequence file used so you don’t have to select it again.
Using Alternate Intervals on the Deviation Curve Display
In Edit Options there is an option that defines an additional interval that can be displayed in the deviation
curve for both the bass and the treble sections. By default, only the intervals you select in the selection boxes
on the screen are displayed in black and green in the deviation curve. But if you specify an alternate interval,
that interval will also be displayed with a light blue trace. The alternate intervals are not used in any automatic
adjustments. They are displayed just for informational purposes.
The alternate intervals can be useful when adjusting the tuning curve if you want to ensure that two different
intervals come out the way you want them. For example, suppose the regular interval selections are 6:3 single
octaves for the bass and 4:1 double octave for the treble. Then suppose that we also define alternate intervals
of 8:4 single octaves in the bass and 4:2 single octaves in the treble. The deviation curves might look like this:

Note how the 4:1 interval (shown in black and green) is about 1.8 cents wide at the middle of the scale and
gradually becomes beatless in the high treble. However the 4:2 interval (shown in light blue) is beatless in the
middle of the scale (at D#5) and becomes about 6 cents narrow at the very top of the scale.
This actually is a very desirable outcome. The 4:2 interval is more important in the middle of the scale, and the
4:1 interval generally is considered a better standard for judging the high treble. The two traces in the deviation
curve show a gradual transition from beatless 4:2 octaves in the middle and beatless 4:1 double octaves in the
high treble.
In the bass, we see that while the 6:3 octaves (in black and green) are all fairly good, the 8:4 octaves (in blue)
generally are narrow throughout the bass.
When alternate intervals are specified, the usual Zoom function (activated by the Z key) is modified slightly.
Normally the Zoom function redraws the curves so that they are just contained in the display. A second
consecutive Zoom will return to the original default zoom level. But if an alternate interval is specified, there
are three stages in setting the zoom.

37

1. The first application of the Zoom function redraws the display to just contain the primary
intervals in the deviation curve. The alternate intervals are allowed to run off the top or bottom
of the graph.
2. The second application of the Zoom function redraws the display to just contain both the primary
and alternate intervals. Nothing is allowed to run off the top or bottom of the display.
3. The third application of the Zoom function redraws the display with the original zoom settings,
allowing the alternate intervals again to run off the top or bottom of the screen.
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Chapter

Menu Items and Options
Here is an item-by-item list of the menus used in TuneLab Pro.

File
New
New Tuning File - clears out any existing tuning file data and loads from DEFAULT
Split Scale Tuning File - asks for the break, then starts new tuning file
Unequal Temperament File
…by manually entering offsets - If you know the 12 offsets that define an new

unequal

temperament, you can enter them here and make your own temperament file.
- If you have a piano that has been tuned aurally
in an unequal temperament and you would like to make a file that duplicates that
temperament, match at least one octave from that tuning using Custom Stretch values and
then choose this menu item to use those Custom Stretch values to make an unequal
temperament file.
Open Tuning File - lets you choose an existing tuning file to load
Save Tuning File - saves the current tuning data into the current tuning file name
Save Tuning File As… - saves the current tuning data and lets you choose a new file name
Read Temperament File - lets you choose an existing unequal temperament file, (or press F5)
Rotate Temperament Starting Note - lets you transpose a temperament so that it is based on
some other note besides C
Cancel Temperament - returns the current tuning to equal temperament
Select Aural Tuning Sequence - lets you pick a file that defines the tuning sequence you want
…from Current Custom Stretch values

Calibration
Calibrate to External Reference

- TuneLab calibrates to a reference tone, such as the NIST
tones or some other trusted source of pitch.
Calibrate to Internet Time Server Reference – Six hour unattended process of calibrating
by means of precise time references.
Calibrate Sound Gen from Listen Mode - Choose this item only if you need precise sound
generation capability and have already done a basic calibration of TuneLab in the listening
mode.
Save Overpull Pre-measurements - Use this function after you are done tuning a piano in overpull mode if you want a record of all the pre-measurements for off-line study.
Exit - Exit from TuneLab. TuneLab will prompt you if you need to save a tuning file first.

Edit
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Edit Inharmonicity Constants

- Review and possibly edit the inharmonicity constants that resulted
from inharmonicity measurements, (or press Insert) (Not generally needed)
Edit Template Tuning Curve – This item switches the screen to the tuning curve adjuster. You can
also switch to the tuning curve adjuster by pressing the T key on the keyboard.
Edit Partials – This item allows you to review and possibly change the table of partials currently in
use. This table will be saved with the current tuning if you save the tuning file, (or press P)
Change Partial Lower - overrides the tuning file and changes to a lower partial, (or press F3)
Change Partial Higher - overrides the tuning file and changes to a higher partial, (or press F4)
Enter Offsets - Allows you to enter the Overall Offset or Custom Stretch offsets, (or press F6)
Transfer Offset to Custom Stretch - If you have adjusted the offset for the current note and
would like to make that offset a permanent feature of the tuning for the current note only, use this
menu item, (or press F9)
Edit Options - allows the setting of various options, listed later

View
Zoom Spectrum Display
Wide View - shows many partials at once, (or press “-”)
+/- 260 cents - shows ±260 cents around the current note and partial, (or press “+” or “-”)
+/- 130 cents - shows ±130 cents around the current note and partial, (or press “+” or “-”)
+/- 50 cents - shows ±50 cents around the current note and partial, (or press “+”or “-”)
+/- 260 cents with Middle Zoom - shows ±260 cents with an expanded display of ±10 cents
+/- 130 cents with Middle Zoom - shows ±130 cents with an expanded display of ±10 cents
Exam Scoring - If you have matched an examinee’s tuning by transferring all his/her offsets

to
Custom Stretch values, use this function to compare the resulting tuning with a previously saved
master tuning which was also recorded using the Custom Stretch values.
Comments for this tuning - Lets you save comments attached to the current tuning file

Modes
Generate Sound Output - switches to making tones instead of listening to them, (or press S)
Listen to Sound Input - switches back to listening instead of generating tones, (or press S)
Note Switching
Manual only - change notes manually (Shift down arrow)
Auto up - enables auto note switching to higher notes (Shift right arrow)
Auto down - enables auto note switching to lower notes (Shift left arrow)
Auto both directions - enables auto switching in either direction (Shift left and right arrows)
Auto Measure - enables auto sequencing through defined notes to measure for a new tuning
Aural Tuning Sequence - enables following an aural tuning sequence that was previously

selected from the File menu (Cntl-A)
Over-pull Mode - Manage all the phases of Over-pull tuning, (or press F2)
Locking Mode – This item enables the mode where TuneLab automatically

adjusts the offset to
match the tone that it hears. See the chapter on “All About Offsets” for more information.

Tuning Exam
Detuning - adds detuning offset for test prep
Capture - displays offsets rounded to 0.1 cents

and makes it easy to record them as Custom
Stretch values for saving into a master tuning or examinee tuning file
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Stop - turns off detuning or capture modes and goes back to normal
Record A4 Fundamental for RPT Exam – assumes overall offset is the A4 error

Help
Help Topics - invokes the complete help file for reference
Tutorial - invokes a special help file that leads you through a step-by-step tutorial
About this version - gives information about this version of the program
Enter License Information - lets you convert the free trial version to the paid version

Options (in Edit Options box)
Spectrum Display
Use wide traces in spectrum graph - makes traces three pixels wide instead of one pixel
Font Size for tuning error display in spectrum graph – to make this number easier to read
Phase Display
Speed Factor - scales the speed of the phase display for all notes
Switch to Cents at… - This item specifies the note at which the

speed of the phase display switches to
cents. Below this note, the speed of the phase display is based on beats. One beat of pitch error means
one complete cycle of the phase display (if Speed Factor is set to 1). Above the specified note, the
phase display speed represents the pitch error in cents. The higher you put this changeover point, the
faster the phase display will be for the higher notes.

Inharmonicity
Start Measuring Inharmonicity Immediately – used for new tunings to avoid having to click on the

Measure button to start each measurement
- allows you to redefine which notes are to be measured for inharmonicity in a
new tuning

Measure Sequence

Partials
Make partial changes persistent

– This option remembers in the tuning file any changes made to the
selected partial using the F3/F4 keys. If this option is not checked, all such changes are temporary, and
the partial selections in the tuning file stay as they are.
Auto Partial Selection – This option specifies which notes, if any, should use automatic partial selection.
This option is for the lowest bass notes. See Chapter 8 for details. The default is for no auto partial
selection. The highest partial that may be used can also be specified.
Create sound with partials and inharmonicity – Instead of the normal operation of creating tones
with a single partial, this option causes tone generation to be a complex combination of partials.
Edit table of partials - allows you to edit the partials used in tuning, either for the current tuning or for
newly-generated tunings

Temperaments
Normalize Historical Temperaments

– This option allows the selection of three types of
normalization: none (as is), normalize so that A=0, and normalize so that the average offset=0. The
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normalization shifts all 12 offsets for tuning but does not change the original offsets in the tuning file or
the temperament file.
Files
Treating Offsets between sessions and tuning files

- allows you to specify if the overall offset
will be saved and restored from tuning files or between times when the TuneLab program is started
up
Always start TuneLab with the tuning file that was last used - Normally when TuneLab is
started up, the tuning in effect is a no-stretch “untitled” tuning. When this option is selected,
TuneLab remembers the tuning file in effect when it is shut down and automatically loads that
tuning file when it is started up again.
Comment Files have this extenstion - Normally TuneLab is started up, the tuning in effect is a
no-stretch “untitled” tuning. When this option is selected, TuneLab remembers the tuning file
in effect when it is shut down and automatically loads that tuning file when it is started up
again.

Intervals

Specify alternate intervals for display in the deviation curve.
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